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Introduction 
TekPatrol is a unique asset management system that monitors and protects any device over a network.  

Overview 
 
Organizations with investments in audiovisual equipment find benefits in monitoring the status of their 
equipment in real time. These benefits include improved security, maintenance, energy conservation, 
supply replenishment, asset management, and IT administration, among others. 

 
 
TekPatrol includes the following: 
 

 TekMonitor 

 TekManager 

 TekWizard 

 TekControl 
 

TekMonitor 
TekMonitor is an Ethernet-based mini-control system that allows 
you to easily monitor and control projectors, plasmas, screens, 
lights and more. The current TekMonitor is also called the TEK 
1 and is sometimes referred to as the host. 
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TekManager 
TekManager is an administrative software tool used to view, control and configure all of the TekMonitors 
on a network. TekManager may operate on multiple computers, but only one should be configured to 
synchronize the TekMonitor clocks. TekManager can be configured to operate as the Administrator, Help 
Desk or as a Monitoring station.  
 
TekManager uses an auto-discovery method to locate TekMonitors. This allows TekMonitors to be 
installed using DHCP. Once a TekMonitor is placed within a project, TekManager uses the last know IP 
address for polling the TekMonitor. If TekManager loses communication with a TekMonitor, auto-
discovery is initialized until the TekMonitor is found, removed or placed in the Holding Area. Setting a 
TekMonitor to a static IP address disables the auto-discovery feature for this TekMonitor. 
 
 
 

 

 
TekManager 
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TekWizard 
TekWizard is an application that runs in TekManager to initially configure a TekMonitor. To simplify the 
configuration of a TekMonitor, TekWizard uses two types of templates called TekMonitor and Device 
Templates. These Templates increase productivity by reusing information. Templates can be selected, 
modified and saved to a file or within the TekMonitor. TekWizard will then guide you through a step-by-
step process to configure a TekMonitor and create Templates. 
 
 

 
 

TekWizard 
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TekControl 
 
TekControl is a Windows application running on the room’s computer to allow a user to easily control a 
TekMonitor. Configuration of TekControl allows for different displays for both the user and administrator. 
There is also a configurable Window’s Tray icon menu. 
 

 

TekControl 

Features 
 

Security – This system can detect the removal of projectors and other audiovisual equipment and raise 
alarms though a number of pathways. These pathways include email, instant messaging, cell phone text 
messages and alerts displayed on a central management console. The alarm includes information on the 
location of the projector and its manufacturer, model, and serial number. 
 

Maintenance – This system queries projectors that keep track of remaining bulb life. TekMonitor also 
maintains it own lamp-life timer for projectors that do not offer this feature. Similar functionality is provided 
for air filter replacement or cleaning, called a maintenance timer. 
 

Energy Conservation – TekMonitors may be integrated with occupancy sensors and lighting 
controls. The occupancy sensor acts as an input to the TekMonitor by creating both on and off events. 
These events are then used to turn on and off the lights and A/V equipment. 
 
By utilizing schedules a TekMonitor can define events at particular dates and times. This makes it 
possible to turn on an LCD at 7 AM and off at 5:00 PM.  

http://www.tekvox.com/
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Inventory – Like many institutions, it is typical to have several projector models with different types of 
bulbs and filters. Keeping track of the inventory for the bulbs and filters can lead to inadequate 
maintenance scheduling and inventory. The objective of keeping bulbs in stock and buying in round lot 
quantities to get appropriate price breaks requires anticipating monthly or annual bulb replacement 
cycles. This system keeps track of remaining lamp hours per projector along with the bulb model number. 
 

Asset Management – Many organizations audit their fixed assets once or twice a year. Projectors, 
being both valuable and portable, are of particular interest. The TekMonitor maintains Manufacturer and 
Model Number, Serial Number, Asset Number, Installation Date, and Warranty Expiration Date for each 
projector. Having this information can expedite analysis of remaining useful life. 
 

Administration – Projectors are used in conjunction with various other devices and their associated 
media, including PCs, DVD / VCR players and Document Cameras. Administering these systems can 
consume a lot of time. The TekPatrol system allows an administrator to view the rooms operation and 
provide solutions remotely. 
 

Installation 
 
A number of features are intended to simplify installation. These include: 

 
Project 

o The entire system can be preconfigured and saved into a project file before the TekMonitors are 
physically installed. 
  

Auto-Discovery 
o It is not necessary to assign a static IP address to the TekMonitors, although this option is 

available. All TekPatrol software uses an Auto-Discovery method to locate the TekMonitors set to 
static or DCHP IP addresses within an IP address range.  

 
Driver Libraries 

o A driver for a particular device is selected from a driver library sorted by manufacturer and model 
group. This library is obtainable by TekManager at any time from our FTP site. 

 
TekWizard Templates 

o Certain TekMonitor settings exist independently of any particular device model, such as location 
and IP configuration. Others are device specific. The administrator can define TekMonitor settings 
for different campuses and combine these with Device settings for different equipment 
configurations. 

 
Predefined Applications 

o In the TEK 1 Applications document there are several applications illustrated. To provide a quick 
an easy method to apply one of these applications, an installer only needs to select an application 
template in TekWizard. 

Site Planning 
Before creating a TekManager project it is always best to ensure that a TekMonitor driver exists for the 
device or devices that you want to control. If one does not exist, TEKVOX will create it if the protocol is 
available. All we need is the model number and make of the device, and occasionally we will need the 
device. There is no charge for this service as long as you do not require something special.  
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Facilities Definition 
Projectors and their associated TekMonitors are described in terms of Location (Campus), Building, 
Group (Department), and Room. A projector would be, for example, located in Room 113B of the 
Chemistry Department in the Main Building of Washington High School. In addition to the Main Building, 
Washington High School might have a Gymnasium, Auditorium, and Industrial Arts center. 
 
Facility names may consist of upper and lower case alphanumeric characters, along with spaces and a 
range of special characters.  
 
The following names are okay: 
 
MacArthur H.S. 
Room 1.12.05 
Room 15A (Back) 
Chemistry Department [Upper Level] 

TekMonitor Naming Conventions 
A TekMonitor is typically connected to a display device, and perhaps an occupancy sensor, screen 
up/down controller, and lighting controller. The naming of a TekMonitor might be as simple as Projector or 
Plasma, or you may wish to include more information. If there is more than one TekMonitor in a room, it is 
helpful to specify either the device, or if there are two projectors in the room, their relative placement.  
 
Examples might include: 
 
Chemistry Department (Building) 

CD 113A (Room) 
  CD 113A Sony PX40 (TekMonitor) 
 
History Department (Building) 
 HD 132 (Room) 
  HD 132 Sony PX40 – Left (TekMonitor) 
  HD 132 Sony PX40 – Right (TekMonitor) 
 
A TekMonitor uses its name for the ‘From’ entry in an Email attachment if the ‘From’ is left blank. 

http://www.tekvox.com/
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Device Inventory 
In some cases TekMonitors are part of an initial installation which includes projectors, occupancy 
sensors, lighting, and screen controls. For these types of installations the site planner may have to work 
with the System Integrator (the A/V equipment vendor) or the General Contractor of the building to get the 
specific make and model of the equipment due for delivery. 
 
For other installations some equipment may already be present in the organization. The inventory in this 
case needs to include the device manufacturer’s Name, Model Number, each Serial Number and the 
organization-assigned Asset Number, if one exists. Where applicable, it is helpful to have the installation 
date (the date the equipment was brought into service) and the warranty expiration date, if these can be 
found. 
 
In either case, one should create a spreadsheet with the following information: 
 
TekMonitor 

Location, Building, Group, Room, TekMonitor Name, Asset Number, Serial Number 
Device 

Manufacturer, Model Number, Serial Number, Asset Number, Installation Date, Warranty 
Expiration Date 

 
It is very important to know the installed location of a TekMonitor along with its serial number. 
 
An Example spreadsheet can be downloaded from here: 
www.tekvox.com/downloads/TEKVOX_INSTALLATION_REPORT.xls 

Network Resource Requirements 
Each TekMonitor uses an Ethernet port on a router, hub, or switch and one IP Address. The IT 
administrator may wish to allocate a block of static IP addresses for the TekMonitors, or allow them to be 
configured as DHCP. 
 
The TekManager application auto-discovers TekMonitors by scanning all addresses set within a range. 
TekMonitors respond to polling queries with an identification response that includes a unique serial 
number. If the IT administrator requires the MAC address for each TekMonitor before allowing it to be 
placed on the network, you will find the MAC address on two stickers within the TekMonitor package. The 
MAC address is also available from properties in TekManager.  
 
The IT administrator can define an arbitrary number of subnets, so a separate range of addresses may be 
assigned to each building or campus. In general, the more closely the range of IP addresses matches the 
range of addresses actually used, the more efficient the discovery process will be. 
 
When TekManager is running, it will poll each known TekMonitor once a minute. While this polling 
process invokes little overhead, the number of messages is proportionate to the number of TekMonitors 
installed. There is no real set number to the maximum number of TekMonitors supported by one session 
of TekManager.  

http://www.tekvox.com/downloads/TEKVOX_INSTALLATION_REPORT.xls
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Equipment Installation 
 
See TEK 1 User’s Manual. 
 

Software 
All software runs on Microsoft Windows XP, Vista and Windows 7 using the .Net Framework 3.5 runtime. 
For Microsoft Vista and Windows 7 it is best to select Run Program as Administrator in Properties / 
Compatibility of the TekManager.exe file usually located at C:\Program Files\TEKVOX\TekManager. 
 
Note - there are several mouse right-click menu items. So don’t hesitate to try a right-click within different 
panels. Drag-and-Drop is also utilized within TekPatrol programs. To select an item for Drag-and-Drop it 
is sometimes necessary to left-click on the item release and then left-click again to fully gain focus. 
 
The TekPatrol system includes three PC based applications which include: 

1. TekManager / TekWizard  
2. TekLink 
3. TekControl 

TekManager 
TekManager is Administrative/Installer, Help Desk and Monitoring software tool used to view, control and 
configure all of the TekMonitors on the network.  
 

Icons used by TekManager 

 Holding Area - Not Configured 

  Holding Area - Configured 

 Holding Area - Configured with Error 

Project - Phantom 

Project - Active with Error 

 Project - Active 

 Project or Holding Area - Not Active, Lost Communication 
 

http://www.tekvox.com/
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TekManager has five main operational panels: 
 Holding Area 
 Project 
 Properties 
 TekMonitor View 
 TekMonitor Control 

 
Each of the panels is an independent dockable entity except for the TekMonitor Control, allowing for 
positioning anywhere within the TekManager work area. It is also possible to detach each panel from the 
main application work area to allow for enhanced viewing. All closed panels may be retrieved via a main 
View menu sub-option selection. The following subsections describe each panel in more detail. 
 

Holding Area 
During a TekMonitor search, TekManager places each found TekMonitor that is 
not already part of the current Project into this panel, as shown by a blue star 
along with their serial number and firmware version. A right mouse click within the 
Holding Area displays menu items for these TekMonitors. The Update TekMonitor 
selection can be used to clear possible project problems with a TekMonitor by 
reinitializing its project settings. 
 
 

Project 
A Project displays each TekMonitor assigned to the Project in a tree like structure. Each TekMonitor has a 
hierarchy of names assigned to it for grouping as follows: 
  

 Project – Root Node 
 Location (Campus) 
 Building 
 Group (Department) 
 Room 
 TekMonitor Name 

 
The Project Root Node provides for multiple locations to be grouped under a common node.  Context 
options allow for inserting new facility levels, removing facility levels, and editing 
the names of the selected facility levels.  Changes made are propagated to any 
TekMonitors located below the modification hierarchy. 
 
There are also an options to perform a Macro or System-Off command at the 
facility level chosen forcing the command to be submitted to all TekMonitors 
contained below the facility level hierarchy. 
 
Projects can be created by the following: 

 Drag-And-Drop a configured TekMonitor into a Project 
 Configure Phantoms or Active TekMonitors using TekWizard 

                                                                                                          
A Project is created using TekWizard to configure both Phantom (shown as 
a dark gray star) or Active TekMonitors (shown as a green star). A 
Phantom TekMonitor represents an abstraction for a physical unit that is 
only a place holder for configuration data. An Active TekMonitor is 
physically present on the network and is operating. A Project can also be 
created by dragging multiple TekMonitors within the Holding Area into a 
clear area of the Project. Once a project is created, it can be saved and 
opened from the file menu. This method of creating a Project allows for a 
complete TekPatrol system to be configured offsite, and once onsite the actual TekMonitors are located 
and placed in the Holding Area by TekManager search. The TekMonitors within the Holding Area can 
then be dragged-and-dropped onto their respected Phantom TekMonitor.  This will result in the system 
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loading the defined phantom data into the TekMonitor, and subsequently replacing the phantom.  
TekMonitors may also be dragged in selected multiples from the project tree back into the holding area 
for later reconfiguration. 
 
A right mouse click on a selected TekMonitor in the Project window 
displays a list of menu items for this TekMonitor. From this menu list the 
View Editor and TekMonitor Control can be executed. In addition, 
individual macros stored within the TekMonitor may be executed along 
with an option to perform a general System-Off command. Refreshing a 
project causes the project to go online if it is off line while Refresh 
Selected forces a complete data refresh from the monitor selected.  A 
TekMonitor Clone feature is included to allow for cloning specific monitor 
settings from a source monitor to many target monitors allowing for 
easier system configurations. 
 
 
 
The Clone option allows for selecting specific categories of settings 
to be merged with the target monitor settings.  Once the desired 
property category selections are made, the settings may be 
programmed into the target monitor(s) chosen from the Holding 
area monitors displayed and subsequently accessing the “Apply 
To” button. 
 
 
The bottom right status of the TekManager form is a list of informative details about the project. From left 
to right the displayed information presents the project refresh time indicating elapsed time, the 
Online/Offline status of the project and the current IP being probed in the search process. A TekMonitor is 
only placed in the search process if it is in the Project area, set to DHCP and did not respond during 
polling. The elapsed time indicator will also display current activity with regard to refreshing the project, or 
searching for lost or offline monitors. The refreshes occur on 1 minute boundaries while the searches will 
commence at 10 minute intervals. 
 

 
 
 
Properties 
The Properties panel allows for viewing, modifying and copying/pasting 
parameters in a selected TekMonitor. Selecting a TekMonitor in any panel 
displays it Properties. 
 
Within Properties the following can be viewed or modified: 

 Asset Information 
 Allows for keeping track of the TekMonitor and its monitored 

device.  
 Email Messages 

 Allows for viewing and editing of the Email messages. 
 Facility 

 Allows for viewing and editing of the Project tree information. 
 Host Settings 

 Allows for viewing and editing of the SMTP settings and 
enabling Usage Reports, Error Messages, Security, System Off Timer, UTC Offset and 
Device Lock. 
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 Macros 
 Allows for viewing and editing of the Macros. In addition, copy and pasting of macros 

between monitors is provided via the right mouse context menu. 
 Network Settings 

 Allows for viewing and editing of the Network settings. To set as static change DHCP to 
False. When finished, click-on Update IP Settings button. The MAC Address is also 
displayed. 

 Schedules 
 Allows for viewing and editing of the Schedules.  In addition, copy and pasting of 

Schedules between monitors is provided via the right mouse context menu. 
 TekMonitor Information 

 Allows for viewing and editing of the TekMonitor Name and viewing of its Serial Number 
 
 

TekMonitor View 
To view several active TekMonitors on one screen a column grid display is utilized. This display is called 
a View. Each View consists of a group of selected columns. Using Views allows the user to save and 
select different displays. For example; one TekMonitor View could be inventory control, another 
operational control and another security.  
 

 
 
Another feature of the TekMonitor View is the TekMonitor Map which will be describe in more detail 
further into this document. This feature allows each TekMonitor to have its parameters mapped to a 
specified column. Some drivers do not share the same memory location for their parameters, to solve this 
problem a TekMonitor Map is assigned to each TekMonitor. 
 

TekMonitor Control 
A TekMonitor and the devices that are connected to it can be 
remotely controlled via TekManager by selecting a 
TekMonitor and either double-clicking on it or select 
TekMonitor Control from the mouse menu.  
 
TekMonitor Control allows for the following selections:  

 Host  
 Device 1 
 Device 2 (TEK2) 
 Device Status 
 Location 
 Links 
 Macros 
 Email 
 Errors 
 Tools 

 
The View of these items depends on the access level assigned to the project. Only the administrator’s 
level can select all of the items. All other levels can only view Control.  
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Host/Device 1 and 2 Tabs 
From these panels (shown above) a user is able to quickly control 
or view the status of a TekMonitor and associated controlled 
devices 1 and 2(TEK2). There are three separate displays for the 
control tabs which are selectable by the Access Level in the Project 
menu and the Control Selection within the Tools/Configure Control 
menu.  The color of the buttons can easily be changed from a 
mouse right-click. 

 
Device Status  
Selecting the Device Status tab allows for viewing the status and 
modifying a selected operation on the TekMonitor and the 
devices it is connected to. The Port pull-down list displays the 
controllable items for that port. To modify or control an item, first 
select the item and then double-click on it. This displays the 
Control popup with a list of the selectable options for the control. 
In the following example the V. Projector Power is Off and it is 
being turned On.  

 
The Device Status is the only place to change integer items like:  

 Remaining Maintenance 
 Remaining Lamp Hours 
 Volume Level.  

 
 
 

 

 
 

 
Port Selection              Command Selection            Command Option Selection 

 
 
 
Location 
This tab allows for viewing information about the installation facilities. 
The box at the bottom, TekMonitor Information, allows for editing but 
not adding information. Use TekWizard to add information. 
TekMonitor Information can only be modified it must first be created 
in TekWizard. 
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Links 
The Links tab provides a means to gather various types of 
information regarding the monitor location and/or setup data in one 
area for later retrieval. This generates a convenient means of 
holding specific data in order to aid in the maintenance of the 
system. Items are added by simply dragging each item from the 
Windows desktop and dropping into the Links window. Double 
clicking on the individual Links items executes the application 
associated with the item. Programs like Crestron’s Xpanel and VNC 
programs to view AMX touch panels can be placed here.  
 
 

 
Macros 
From the Macros tab the stored Macros commands can be selected 
and executed. Use this feature to remotely control a device. For 
example; if the projector needs service, execute Macro 3: Disable 
Security. This will disable the hardwired security detection to the 
projector so it can be worked on without sending an Email to 
security.  

 
These Macros cannot be modified. Access the Macros from the 
Properties panel to modify these commands. 

 
 
 

Email 
From the Email tab the stored Email messages can be selected 
and sent. Use this feature to test the configured SMTP settings.  

 
These Email messages cannot be modified. Access the Email 
Messages from the Properties panel to modify these messages. 

 
Errors 
Use the Error tab to view any errors that are produced by the 
TekMonitor. The Error messages can be cleared using the Clear 
Error Messages button. 

 
Tools 
From the Tools tab selection the TekMonitor can be synchronized with the PCs’ clock or Reset. Normally 
TekManager automatically maintains this clock. See Project/Settings menu for more information. 
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Menu 
Like most other Windows applications TekManager uses dropdown menus located on the menu bar.  
 

 
 

 
File 
From the File menu a new Project can be created or a Project can be saved or opened. As usual, the 
program can be exited from here. 

 
View 
The View menu allows for hiding or displaying the Holding Area, 
Project, Properties, and View panels. Since TekManager allows for 
dockable windows, you might want to put windows back to their original 
positions. Selecting Restore Default View puts TekManager back 
together. An additional feature selection is the ToolTipEnabled 
function.  By enabling this feature, specific status data may be viewed 
when hovering over a specific monitor.  The items to display are 
configurable through the Configure Control, Popup Status menu 
described later.  Finally, the View menu provides for the displaying of a 
selected TekMonitor Control form and the TekMonitor View templates.  
 
Selecting TekMonitor Control displays the controls for a TekMonitor. 
These controls can also be viewed by double-clicking on a selected TekMonitor or by a right-click 
menu item.  
 
Choosing Select TekMonitor View displays the selection form for the different TekMonitor Views. To 
create and edit these Views see TekMonitor View in the Tools menu.  

 
Project 
The Project menu has three selections: 
 

1. Settings 
2. Refresh All 
3. Access Level 

Settings 

To configure a Project, it is necessary to create an IP 
range or multiple IP ranges. The default range is 
actually derived from the IP address of your PC. This 
will help you in locating TekMonitors. Some systems 
might be split across different subnets. For these 
types of systems it is necessary to create another IP 
range for that subnet. A valid range can be 
192.168.1.1 to 192.168.100.1. 
 
A project name can be assigned to your project at 
the top of the Project form.  
 
The File Name is not editable and displays the 
Project’s file name and location once it is saved. 
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An Administrator Password is utilized to gain access to the Administrative operations. By default 
this password is Tek6373. Only the numeric part of the password can be changed.  
 
The Auto Save allows TekManager to perform a save every 10 minutes if the project has been 
changed. 
 
TekManager can operate as the Administrator, Installer/Technician, Help Desk, Monitor view, and 
operational tool for the TekMonitors. By checking Enable Polling, TekManager becomes the 
administrator’s, Help Desk and Monitor view to all TekMonitors. If Enable Polling is not checked, 
then TekManager becomes a technician’s tool.  
 
The Enable Filtering option provides two means of viewing active monitors within the project view.  
If checked, only the monitors within the selected level of the project tree view hierarchy are 
presented.  If not selected, all monitors are displayed, and the current selected item in the project 
tree view is indexed into the view range.  All monitors are displayed with respect to the project tree 
view. 
 
Synchronize TekMonitor Clock keeps all of the TekMonitor clocks in-sync with the PCs’ clock 
running TekManager. The time that is set by TekManager is calculated by a time zone offset 
between the PC and the TekMonitor. This could cause problems if you 
move between time zones and you do not set your PCs’ Time. This 
feature should only be enabled on an administrator’s PC that is 
stationary.  
 
To Add, Edit, or Remove an IP Range click on the IP Ranges field with 
the right mouse button. The Add Range context menu selection 
provides a blank IP address range to fill in. To edit a range, you again 
must select an IP Ranges field item or double-click on the range item. 
When adding or editing a range, a description for the range can be 
included. The range setting is only the last three octets and the first 
octet is always 0-255.  
 
Do not change the Port numbers or the Pass Code until you have actually configured the 
TekMonitors. The Project maintains this information for each TekMonitor.  

Refresh All 

Selecting Refresh All provides a quick way to ensure all of the information in the TekMonitors is up 
to date.  

Access Level 

TekManager allows for three access levels; Administrator, Help Desk and Monitor. Administrator 
has full access to TekManager while Help Desk and Monitor are only able to view the properties 
and modify selectable control items in TekMonitor Control. 

 
Search 
There are two selections in the Search menu: 

Single IP Address 

If you know the IP address, give this a try. 

IP Address Range 

If you are looking for a group or all of the TekMonitors with the same Pass Code, give this one a 
try. 
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To perform a search, first select the range and then 
click-on Search. It is possible to add and edit a range in 
the same manner as the ranges in the Project Settings 
selection, but any modifications made in Search are not 
saved when this form is closed.  The “Search all IPs” 
option allows for an unfiltered search where all units, 
whether already in the project or not, will be tracked. 
        
 Search IP Address Range 
To permanently modify an IP range use Project>Settings.             

 
TekWizard 
There are no menu selections for TekWizard. Selecting TekWizard starts the TekWizard application. 

 
Tools 
The menu items for Tools are: 

 Options 
 TekMonitor View 
 Configure Control 
 TekLink 
 Update Drivers 
 USB Debug Port Access 

   

Options 

From Options menu item, the current paths of the Driver, 
Template, and Project are displayed and modifiable. This 
allows you to place location specific Drivers, Templates 
and Projects in your own specified locations. 

 

TekMonitor View 

Select this menu item to configure TekMonitor View. The following items are selectable from this 
menu: 
 Master Column List 
 Editor 
 Default Map 

 

Master Column List 

A Master Column List is utilized to maintain a list of all possible column names along with their 
displayed names. To add a new name, select the last index, and enter a Column Name (No 
Spaces), Column Heading Name (Displayed Name), Select the Column Type (How it is to be 
displayed), and the Column Width (Usually 85 - 140).  

 

Editor 

To modify the TekMonitor View, a TekMonitor or Phantom must first be selected.  
 

A TekMonitor View Editor is utilized to create different TekMonitor Views and TekMonitor Maps. 
There are two panels in the Editor: 
 TekMonitor Map 
 TekMonitor View 
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TekMonitor View Editor 
 

TekMonitor Map 

Each TekMonitor must have its data or status mapped to a column in a TekMonitor View. This is 
accomplished by selecting a data name in the TekMonitor Map and dragging it into a column 
position in the TekMonitor View 

TekMonitor View 

Different column configurations are created by TekMonitor View. There are currently three default 
TekMonitor Views: 
 Device Status 
 Device Inventory 
 Monitor Status 

 
These default configurations can be modified, 
cloned or a new one can be created by 
clicking on the “New” button. Selecting “New”, 
“Edit” or “Clone”, displays the Select View 
Column Names form. From this form 
predefined columns defined in the Master 
Column List are displayed.  Selected column 
names are displayed in the View Editor. If a 
name does not exist then it must be created 
in the Master Column List described above 
which can be accessed via the Column 
Master Button.  Views may then be individually stored by clicking the “Apply” button from the main 
View Editor window.  Clicking “OK” from the main View Editor window keeps the “Applied” views 
and returns to the main TekManager window.  Clicking “Cancel” aborts all changes and returns to 
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the main window.  Additional buttons are provided in order to aid in view development and 
maintenance, they are described as follows: 
Copy – copies current view in clipboard for later retrieval with paste 
Paste – pastes the view saved in the clipboard into current view 
Set Default Map – redefines default project column list to current column list 
Apply Default - applies current defined default column list to current project monitor data 
Get Map – retrieves view column list saved in TekMonitor memory 
Apply Map To – stores the column mapping definitions into project data area 
Save In TekMonitor – saves view column list into TekMonitor memory 
 
 
Each column in a TekMonitor View has the ability to 
display TekMonitor data as Text, Number or selectable 
Icon. 
 

Icons selections 
include: 

 
 
 
 
 
 
 

Power Icon 
Off Standby On 

   
 

Lamp Icon 
 

 

 
Maintenance Icon 

 
 

 
 

Default Map 

Selecting this menu item displays the current Default Map. Once a Default Map is created all 
newly configured TekMonitors are configured with this map. 
 
Once a TekMonitor Map is created it can be saved as the default map, applied to other 
TekMonitors and/or saved to the selected TekMonitor. Saving to a TekMonitor allows for backing 
up of a project within the TekMonitor. 

Configure Control 

To configure the Control for a TekMonitor, a TekMonitor or Phantom must first be selected.  
 
Double-clicking on a TekMonitor displays a control panel. The contents of this panel are set by the 
current access level and the Control Selection panel. From this panel an administrator can select 
the control items that are displayed for the Administrator, Help Desk and Monitor levels. Items can 
be enabled and disabled by checkbox selections. To help speed up the process, the Administrator 
settings can be copied to both the Help Desk and Monitor settings by clicking on Apply Local. 

Off States On States 

  
  
  
  

 

0 > 0  And <= 50 > 50 And <= 200 >200 

    

0 > 0  And <= 25 > 25 And <= 50 >50 
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These settings may also be applied to another specific TekMonitor by clicking the Apply To button, 
and selecting the monitor that is to assume these settings. There is also a Reset Control button 
provided which allows for returning the settings to initial values. Finally, another field is provided for 
selection of specific data to be displayed while hovering over a particular TekMonitor. This is the 
Popup Status field, and provides a means of quickly getting data on a unit without having to select 
and/or scroll the View panel. Again, data items are added to this popup field by selecting desired 
items from the Control Selection window. 
 

 
 

Control Selection 

Once all of the selections are made, this Control Selection setup may 
then be copied to other TekMonitors by clicking on the Apply To 
button. From the subsequent monitor selection window, select one or 
all of the TekMonitors you wish to copy to, the default is “all” selected.   
It is, however, best to make sure that only TekMonitors with the same 
driver settings are copied to. 

TekLink 

Both TekControl and TekLink create user controls for 
a TekMonitor. When using TekControl, only one 
application is allowed to operate a TekMonitor. 
TekLink can operate at the same time that TekControl 
is running, allowing a user to run TekControl from 
their PC and TekLink from a handheld PC.  
 
A TekLink program is a run once application that can 
send a group of commands to a TekMonitor, similar to 
the Macro settings in TekWizard with the exception of 
conditional statement support.  
 
Once commands are placed into TekLink, a .tdk application file is created, which is associated with 
the TekLink.exe file. A shortcut to the .tdk application file should be created and placed in a folder 
for easy access. This provides an icon that may then be easily selected by right-clicking on the 
shortcut and selecting properties. To run the TekLink application file on another PC, first install 
TekLink, and then copy the application files that were created in TekManager. 
 
TekLink is associated with this Icon: 
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Update Drivers 

The Driver Library files are located on the TEKVOX ftp site. Selecting Update Drivers automatically 
updates the drivers. Drivers are not included with the installation of TekManager. These drivers 
must be updated via an Internet connection. 

USB Debug Port Access 

The USB Debug Port Access launches the TekDebug application which utilizes the internal USB 
port of the TEK2 to aid in debugging hardware setup of the TekMonitor.  The facilities of TekDebug 
are described in further detail later in this document. 

  
 

Help 
The menu items for Help are: 
 

 Contents 
 About 

 
Contents 
Selecting Contents displays this TekPatrol Administrator’s Guide. 
 
About 
Selecting About displays current version along with copyright information. 

http://www.tekvox.com/


 

 26 

TekWizard 
TekWizard is used to configure a TekManager 
Project or a TekMonitor directly. During system 
configuration, TekWizard guides the administrator 
through an intuitive process of; entering information 
about the TekMonitor, selecting device drivers, 
creating macros, events, and schedules. Navigation 
through the TekWizard is accomplished by using the 
Previous and Next buttons or clicking on any of the 
following eight steps:  
 

 START 

 LOCATION 

 SETTINGS 

 DEVICES 

 MACROS 

 EVENTS 

 SCHEDULES 

 FINISH 
         TekWizard - START  
 

START 
During the Start process, the administrator can select from a set of TekMonitor and Device Templates to 
utilize “as is” or create an independent template. The purpose of the templates is to increase productivity 
by reusing common information. Included in TekWizard are several application templates that match the 
described application in the CS - TEK 1 Applications.pdf. By using these templates, an administrator is 
able to gain valuable knowledge into the configuration of a TekMonitor.    
 
There are two types of Templates: 

 TekMonitor 
 Device 

 
Having two templates allows for a more efficient way to configure a system. For example; a campus with 
several of the same type of projectors may all use the same Device Template and only slight 
modifications are needed for the TekMonitor Template. 
 

TekMonitor Template 
A TekMonitor template stores general information about a TekMonitor including Location information, 
Network settings, Email settings, Email messages and asset information.      

 
Driver Template 
A Driver template stores information about the connected device on the serial port, inputs name, 
outputs names and configuration, Macros, Events and Schedules.  

 
Get Monitor Templates 
This button allows for downloading templates stored within a TekMonitor, and presenting them in the 
TekMonitor and Device icon lists. They will be indicated by the serial number of the monitor they were 
downloaded from, and template name given when stored. When drivers are stored within the 
TekMonitor via TekWizard, TekMonitor and Device templates are also stored automatically. 
 
The user is required to select a TekMonitor template which then enables the Device template 
selection.   Once the Device template is selected, the user may then proceed to the next step via the 
“Next” button.    
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Another option provided is the “UpdateROM” button which takes the user to the Finish screen 
allowing the user to program ROM updates into the TekMonitor only.   
 
 

LOCATION 
This step allows the administrator to enter general information about the system. As the project is 
being created, the Location, Building, Group and Room entries allow for a quick selection of other 
entries already created. To select these other entries click on the pull-down list selection. General 
information about the room can be placed in the Monitor Information list. This information could 
include bulb model number and instructor’s name and phone number.    

 

 
 

TekWizard - LOCATION 
 

SETTINGS 
Within this step there are four folder tabs to configure 
the operational settings of a TekMonitor. These 
settings include: 
 

 Network Settings 
 Host Settings 
 Messages 
 Asset Information 

 
 
 
 
 
 
 
 
 

TTekWizard - SETTINGS 
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Network Settings 
These settings include a selection for configuring the IP addressing of a TekMonitor as either DHCP 
or Static. By default a TekMonitor is set to DHCP, and as long as the network supports DHCP it is 
best to keep it as DHCP. If the network does not support DHCP, then the TekMonitor must be 
configured before it is installed on the network. See Setting a Static IP address in the TEK 1 User’s 
Manual. A PingIP button is provided to check the static IP for potential collisions prior to assigning it 
to a TekMonitor. Entering a static IP into the IP Address field automatically results in the IP being 
“pinged” on the network, and also crosschecked against existent devices defined in the project to 
guard against potential collisions. Notifications will appear if such a collision is detected. 
 
The Pass Code is a very important setting, and should always be changed from its default of 6373 to 
one that you wish to use. Changing the Pass Code increases security and allows for creating and 
monitoring different TekPatrol groups. One system group could have a Pass Code of 2222 while 
another could be 17777. Allowable ranges for Pass Code are numeric values from 1 to 66535. If a 
Pass Code is forgotten, it can only be found by connecting to the serial port of the TEK 1 (See 
Determining the Current IP Address in the TEK 1 User’s Manual) or through the debug port of the 
TEK 2. 

 
Host Settings 

 

 
 

The Host settings are used to setup the Email accounts, Email notifications, Security, System Off 
Timer and Time Zone. Mail account settings are first entered into this area including the server, port, 
and logon information. In addition, the TekMonitor can operate two Email accounts that may, or may 
not require authentication. For accounts that require authentication, the Username and Password 
must be entered. Leave these blank for non-authentication accounts.  

 
The “From” Email entry is optional and is normally left blank. If the “From” Email entry is left blank, the 
TekMonitor inserts its own name by default. Entering a name in the “From” textbox replaces the 
default “From“ name. 
 
There are two sending Email addresses, Normal and Security. The Normal address is used for 
general Emails like usage reports and error conditions. The Security Email can only be sent when 
defined in a Macro. If you need more sending Email addresses, a forwarding Email account will be 
required. 
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The Notification check boxes allow the TekMonitor to Email Usage Reports at the end of the month, 
and Error Messages when an error is detected.     
 
The System checkboxes allow for Security, System Off and Motion Off Timers to be enabled. Security 
is a status that is tested during an event within a Macro. The System Off Timer works in conjunction 
with the System Off Seconds and the System Off Event. If the System Off Timer is enabled, and the 
System Off Seconds reaches 0, the Macro assigned to the System Off Event is executed.  The 
Motion Off Timer is only active when the TEK 2 is selected on the Device page. It works in 
conjunction with the Motion Off Seconds and the Motion Off Event.  If the Motion Off Timer is 
enabled, and the Motion Off Seconds reaches 0, the Macro assigned to the Motion Off Event is 
executed.  This is typically used to provide an additional timeout window for motion detection devices. 
 
In some situations you may need to monitor devices that are in different time zones. In order to keep 
the TekMonitor clocks in sync with TekManager, a time zone offset is used. Check the “Adjust to 
Daylight Savings Time” (DST) if the TekMonitor is installed in a location that uses DST. 

 
Email Messages 
There are two types of Email messages; Normal and Security. Normal Emails are sent to the typical 
recipient, and can be sent with normal or high priority attributes. Security Emails, in contrast, are sent 
to the security recipient with high priority. These Messages are assigned in Macros, and sent by an 
event that executes within the Macro.  

Normal and Security Email Messages 
 

Asset Information 
Information gathered about the equipment during the installation can be stored in a TekMonitor. This 
information can then be viewed at any time in the Properties panel by selecting a TekMonitor. 

 
   
 
 
 
 
 
 
 
 
 
 

Asset Information and Properties 
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DEVICES 
Initially, a selection for the model TekMonitor to 
program, TEK1 or TEK2 must be made.  The 
default is TEK1, but ensure the appropriate 
model is selected before storing the final data 
into a TekMonitor or as a Template file. 
 
For a TekMonitor to communicate with a device it 
must first be told what device it is to 
communicate with. This is made possible by the 
selection of a device driver. To select a driver, 
make certain that the Serial RS-232 is checked, 
and then click-on the “Select Driver” button. The 
Select Driver dialog appears which allows for the 
selection of projectors, plasmas/LCD monitors, 
and control systems. First select a Manufacturer, 
and then a Model. To view information about this 
device, click-on “notes”. 
 
Hovering over the Inputs and Outputs of the TEK 1 image with the mouse, displays information about the 
connection.  The TEK 2 contains an additional Serial Port which may be enabled. 
                
                                                         
TekWizard - DEVICES 
        
Select Driver and Notes Dialog 
 
There are four Logic Inputs, two 
Digital Outputs, and two isolated 
Relays on a TEK 1, or for Logic 
Inputs and three Digital Outputs on 
the TEK 2.  From the Device 
Settings, you are able to assign 
names, and enable or disable them 
by the checkmark. Logic Inputs are 
used to get status from a device 
like a switch, occupancy sensor, or a connection to ground. Additionally, these input types have only two 
states;   Open/High/Disconnected (Off), or Closed/Low/Connected (On). Any change in a state on these 
inputs causes an event to occur which may then be assigned to a Macro for subsequent processing. 
Digital Outputs, however, are used to control devices that do not require an isolated ground like an LED. 
Finally, Relays are utilized (TEK 1) to control devices that require an isolated ground such as screens and 
controllers.  Options are provided on the TEK 2 for inverting the input or output signals, and defining pull-
up or pull-down termination of the logic inputs.  These are disabled on the TEK 1. 
 
The Digital Outputs and Relays can be; Turned On, Off, Toggled, Pulsed, 
Oscillate, or Stopped. To control the Pulse and Oscillation times, an 
interval time value entry is used. This time entry allows for the setting of the 
time in minutes, seconds, and/or 100 millisecond increments. The 
maximum allowable setting is 60:59:9. 
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 Add Status 

 

This feature provides a method to monitor control system usage 
information. The status information is sent to the TekMonitor by the 
control system using the TekControl protocol. This information is then 
stored by the TekMonitor, and retrieved by TekManager, where it can 
then be placed in database event logs for later data analysis. 

 
 
 
 
 
 
          Status Commands 

TekEzLink™ 

 

TekEzLink is only available on the TEK 2 and above. It is a unique TCP/IP protocol allowing for easy 
integration of AMX and Crestron type control systems. Using this protocol allows the control system 
to control and monitor multiple video projectors in real time without having to do any polling or taxing 
of the control system processor.  Another feature of using TekEzLink is the ability to change a video 
projector without having to modify the control system program. Up to 4 simultaneous connections can 
be made to a TEK 2 using TekEzLink. Each online connection is displayed on the Host tab of the 
TekMonitor Control window. 
 
This is all made possible by using Macros for control commands and a unique mapping of feedback 
data from the loaded driver. Macro commands are configured using TekWizard and in the 
TekManager properties window. The feedback commands are only configured in TekWizard from the 
TekEzLink button on the Device page.   
 
To create the TekEzLink feedback 
elements, just drag the item you 
want to monitor from the Commands 
to the Feedback list. Each feedback 
element is assigned a number 
enumerated 1 through n. Use the 
Up, Down and Delete operation 
buttons to modify the list.  
 
If you need to change the projector 
driver, you must make certain the 
Macros and the TekEzLink feedback 
elements match. For the feedback list you need to print out the old list as a reference utilizing the 
Print Report button on the final page. Then locate the command you want to replace and drag it into 
the Feedback list. Move this new command below the old command and then delete the old 
command by right clicking on it. Do the same to all other commands you need to replace. After you 
have completed all of the commands, you can print the list and compare it with the old list. All 
enumeration values must match there feedback commands.  
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MACROS 
When you need to add some automation or programming to a TekMonitor, try a Macro. The Macro screen 
allows you to name a macro, select a command from the left panel, and drag it into the right execution 
panel.  
 
Macros are an easy method to apply logic and command sequences from the Host or selected driver to 
the controlled device. For example; you have a wall plate with a set of buttons, and you want one of the 
buttons to turn on the video projector with the display channel, VGA 2. A macro can be set up to execute 
both subcommands under one (macro) function call. 
 
Sometimes a Macro needs to have decision making intelligence by executing some logic. This can be 
accomplished by adding a condition. A condition compares a selected Host or driver command value to 
the current value running in the TekMonitor, and branches to the appropriate command sequence based 
on the conditional logic. 
 
Conditions cannot be Nested (Condition within a Condition).  

 
 

TekWizard - MACROS 
 
To create a Macro, do the following: 

1. Name the Macro by clicking-on the Rename button, entering the name and clicking-on the Apply 
button. 

2. If a logic condition is required: 
a. Click the “Add Condition” button or right-click over the right macro construction list area. 
b. Create the condition by selecting the Device, Command, Condition and Setting from the 

top left menu options. 
c. Another condition can be added by checking Multi-Condition, and completing the top right 

selection options. 
d. Finally, drag the Device Commands from the left pane into the True or False Macro as 

appropriate. 
e. When finished, click Ok. 
f. If any common commands are needed, add them here. 

3. If a logic condition is not required: 
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a. Commands are easily added by selecting (double-clicking) a command option from the 
left list and/or dragging it to the right list or selecting the Device Command option, and 
clicking the “Add Step” button. 

 
 

EVENTS 
A TekMonitor is an event driven device. When an event is 
detected, a Macro is executed.  
 
Items that create an event: 

 System Start 
 System Off, System Off Timer 
 Motion Off Timer 
 TekControl On and Off Connect 
 Device On or Off 
 Inputs 1-4 Goes High or Low 
 Schedules 

 
 
 
 
 

TekWizard - EVENT 
 

System Start 
When a TekMonitor is power on or rebooted, a Start event is initiated. Assigning a Macro to this event 
executes the initialization commands after power-up.  
 
System Off or System Off Timer 
If System Off is selected or the System Off Timer expires, the assigned Macro is executed. 
 
 
Motion Off Timer 
If the Motion Off Timer expires, the assigned Macro is executed. 
 
TekControl Connected 
There are certain circumstances that may come up when you need to know that TekControl is 
running or someone is logged into a PC. One such circumstance was used in the case study in the 
TekTranslator data sheet. 
 
Device On or Off 
This event allows for relays to be used to lower and raise a lift or screen when a projector powers on 
or off. The Device off event does not execute until the projector has cooled down. 
  
Inputs 1-4 
An input is in a high or open state if there is no 
connection to ground. Placing a security wire between 
an input on a TekMonitor and ground on a piece of 
equipment, results in a low or closed state. If this wire is 
cut, a “Goes High” event is triggered causing an 
assigned Macro to execute. 

 

 
 
SCHEDULES 
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A TekMonitor maintains four programmable schedules that can either execute a Macro on a precise date 
and time or a daily task. A “Run Once” schedule is executed on a precise date and time. A “Run Daily” 
schedule is executed as a daily task by selecting a day of the week and a time for that day.  
 
When the internal clock in a TekMonitor reaches a defined date/day and time within a schedule, the 
assigned Macro for this schedule is executed.  
 
Note that the internal clock in a TekMonitor can be synchronized to TekManager. See TekManager 
Project Settings. 
 

 
         

TekWizard – SCHEDULING 

 
 
Run Once Schedule 
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FINISH 
Now it is time to save the configuration. There are 
three methods to save a configuration in TekWizard: 

 Templates 
 Phantom TekMonitor 
 Selected TekMonitor 

 
Templates 
As mentioned in TekWizard START there are 
two types of Templates; TekMonitor Settings and 
TekMonitor Device. The path for the Templates 
is shown and can be modified in 
TekManager/Tools/Options. Saving Templates 
increases productivity by selecting a predefined 
Template at the start of TekWizard and then 
making slight modifications. 

TekWizard - FINISH 
 
If the TekMonitor Settings Template checkbox is checked, a name can be entered to store these 
settings or the current Template can be overwritten. An “Ok” to Overwrite dialog will appear if 
overwriting.  An IP check is made on saving to ensure that a duplicate static IP template is not being 
created. 
 
If the TekMonitor Device Template checkbox is checked, a name can be entered to store these 
settings or the current Template can be overwritten. An “Ok” to Overwrite dialog will appear if 
overwriting. 

 
Phantom TekMonitor 
It is always a good idea to create a configuration project using Phantom TekMonitors. Once 
Phantoms are created they can be saved in a project to be used at a later date, or as a backup. To 
save a Phantom TekMonitor, select the “Save To Phantom TekMonitor” radio button. TekMonitors in 
the holding area may then be integrated into the project by dragging them onto their respective 
phantom causing a load process to initiate. This process will load phantom data to the monitor being 
loaded and remove the phantom while replacing it with the now active project monitor. 

 
Selected TekMonitor 
Before saving to an actual TekMonitor, there must be TekMonitors in 
the Holding Area and the serial numbers must match the units you 
wish to load. To save an actual TekMonitor, select the “Apply to 
Selected TekMonitor” radio button and click the “Select” button. A 
TekMonitor list appears and allows for a selection of one or more 
TekMonitors in the Holding Area. Double-click or highlight the 
TekMonitors to load, and click the “Select” button. 
When you are ready to save your settings, click the “Save” button. It 
takes about 30 seconds to load a TekMonitor. It should also be noted 
that the Monitor and Device templates are also loaded into the 
TekMonitors selected whenever the Driver is loaded. 
 
Warning: You can select multiple TekMonitors for loading. This should only be done to load default 
programs or update ROM Image. 

 
ROM Image Only 
By selecting the “ROM Image Only” checkbox allows for loading new firmware without changing the 
driver.           
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Driver Only 
Selecting “Driver Only” allows for loading a 
driver without loading new firmware. After 
loading, a reset of the TekMonitor is performed 
by the software. This method is much quicker to 
load and should only be done if you know the 
firmware is up to date.  For the TEK2, primary 
AND secondary drivers (if selected) are loaded 
in sequence. 
 
Advanced 
Selecting “Advanced” allows for designating 
primary or secondary drivers only for loading, 
this option is only available to TEK2 loading.                                                                   
 

 

The Load Progress Window 

When the loading process commences, a load 
window will appear indicating the progress of 
the process for each unit loaded. As soon as all 
units have completed, whether successful or 
not, the window will indicate success or failure, 
and a close option will then appear. Once the 
load is complete, the current ROM version will 
be indicated with the total elapsed time for the 
load.                    

                Loading in Progress       Load Complete 
 

Reports 
To make it easier to create your control system program a report can be printed of saved to a file. 
This report lists all of the information about the TekMonitor templates. 

Creating a Project 
 
TekManager is a project based application allowing users to create, save and open a Project.  
 
A Project can be created from the following: 

 From Scratch 
 TekMonitors already configured and installed 
 Adding TekMonitors to a currently installed system 

 

Creating a new Project from Scratch 
In this scenario a new Project is being created without connecting to any TekMonitors. Once the 
TekMonitors are installed, they can be located, loaded and brought into the saved Project. 
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Steps to create a new Project from scratch: 
1. Assign Facility Names. 

 Once these names are assigned in a Project, TekWizard can then display these names for 
quick selection Use the right-click mouse button to display a menu in the Project area and 
assign names to the following: 
 New Location 
 New Building  
 New Group 
 New Room 

2. Get the latest TekMonitor drivers. 
 It is always best to start out with the latest TekMonitor drivers. With a WEB connection select 

the Menu item Tools>Update Drivers.  
 

3. Create a name for the project and save. 
 From the File menu select Save Project As. 

4. Create a Phantom TekMonitor or save Templates using TekWizard. 
 Start the TekWizard application and navigate through it. On the Finish page select Save To 

Phantom TekMonitor and click-on the Save button. 
5. Create the TekMonitor view and assign map. 

 Select a Phantom TekMonitor in the Project and click-on TekMonitor Editor from the mouse 
menu or Tools>TekMonitor View>Editor from the main menu. Once a map is created, click-on 
Set Default Map. Setting a Default Map allows other created. 

6. Create All other Phantom TekMonitors. 
7. Assign the Default Map or a new one. 
8. Save Project for Phantom backup. 
9. Set the Search IP address range(s) in Project>Settings. 

 Since this is a new Project, the Pass Code is set to default (6373). Do not change this Pass 
Code. The Project maintains the Pass Code for each TekMonitor. The Default IP range will 
be within the subnet of the local PC.  

10. Search for TekMonitors. 
11. Drag-And-Drop each TekMonitor by serial number into a Phantom. 
12. Save Project to a new name. Do not overwrite the Phantom backup. 

 
 

TekMonitors already configured and installed 
If a TekPatrol system already exist and you do not have a Project for it, then a new Project must be 
created.  
 
You must have the Pass Code before continuing. If you do not have the Pass 
Code and it has been changed, you will need to see Determining the Current IP 
Address in the TEK 1/2 User’s Manual. 
 
Steps to create a new Project from TekMonitors that already exist: 
 

1. Set the Search IP address range(s) in Project>Settings. 
 Create a new range and assign the known Pass Code.  

2. Select Search>IP Range(s). 
 Select the IP range to perform a search on and click-on the Search button. 

3. Found TekMonitors will appear in the Holding Area. 
4. Drag-And-Drop the configured (green) TekMonitors from the Holding Area to a clear area in the 

Project. 
5. Create the TekMonitor view and assign map. 

 Select a Phantom TekMonitor in the Project and click-on TekMonitor Editor from the mouse 
menu or Tools>TekMonitor View>Editor from the main menu. Once a map is created, click-on 
Set Default Map. Setting a Default Map allows other created. 

6. Save the Project. 
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Adding TekMonitors to a currently installed system 
If a TekPatrol system already exists and you already have a Project for it, then use the same Project and 
add to it. Follow the same procedure as (Creating a new Project from Scratch). 
 
If a TekPatrol system already exists and you do not have a Project for it, then you will need to create a 
new project and add new TekMonitors to it. Follow the procedure (TekMonitors already configured and 
installed). The new un-configured (blue) TekMonitors should be in the Holding Area. An un-configured 
TekMonitor in a project does not have a name for Location. If un-configured TekMonitors are in the 
Project, drag them back to the Holding Area before running TekWizard.  
 
 

List of Cell Phone Email Addresses 
 
The following information provides a list of Email address for cell phone providers. For most number use 
your 10 digit cell phone number 2103486565@vtext.com. 
 
Provider Email address Information 
Airtouch (Verizon Wireless) number@airtouchpaging.com.  
Aliant (NBTel/MTT 
NewTel/Island Tel 

number@wirefree.informe.ca   

Alltel number@message.alltel.com.   
Ameritech (ACSWireless) number@paging.acswireless.com   
AU by KDDI username@ezweb.ne.jp   
BeeLine GSM number@sms.beemail.ru   
Bell Mobility Canada 1+number@txt.bellmobility.ca  
Bellsouth number@bellsouth.cl   
BellSouth Mobility number@blsdcs.net   
Blue Sky Fro number@blueskyfrog.com  
Boost number@myboostmobile.com   
Cellular South number@csouth1.com   
CellularOne (Dobson) number@mobile.celloneusa.com   
CellularOne West number@mycellone.com   
Centennial Wireless number@centennialwireless.com  
Cincinnati Bell number@gocbw.com   
Cingular number@mobile.mycingular.com   
Cingular Blue (formerly AT&T 
Wireless) 

number@mmode.com   

Cingular IM Plus/Bellsouth IPS number@imcingular.com  
Cingular IM Plus/Bellsouth IPS 
Cell Phones 

number@mobile.mycingular.com  

Claro number@clarotorpedo.com.br  
Comviq number@sms.comviq.se  
Dutchtone/Orange-NL number@sms.orange.nl  
Edge Wireless number@sms.edgewireless.com  
EinsteinPCS / Airadigm 
Communications 

number@einsteinsms.com  

EPlus number@smsmail.eplus.de  
Fido Canada number@fido.ca  
Golden Telecom number@sms.goldentele.com  
Idea Cellular number@ideacellular.net  
Kyivstar number@sms.kyivstar.net  
LMT username@sms.lmt.lv  
Manitoba Telecom Systems number@text.mtsmobility.com  
Meteor number@sms.mymeteor.ie  

mailto:number@airtouchpaging.com
mailto:number@wirefree.informe.ca
mailto:number@message.alltel.com
mailto:number@paging.acswireless.com
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mailto:number@blsdcs.net
mailto:number@blueskyfrog.com
mailto:number@myboostmobile.com
mailto:number@csouth1.com
mailto:number@mobile.celloneusa.com
mailto:number@mycellone.com
mailto:number@centennialwireless.com
mailto:number@gocbw.com
mailto:number@mobile.mycingular.com
mailto:number@mmode.com
mailto:number@imcingular.com
mailto:number@mobile.mycingular.com
mailto:number@clarotorpedo.com.br
mailto:number@sms.comviq.se
mailto:number@sms.orange.nl
mailto:number@sms.edgewireless.com
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Metro PCS number@mymetropcs.com  
Metrocall Pager number@page.metrocall.com  
MobileOne number@m1.com.sg  
Mobilfone number@page.mobilfone.com  
Mobility Bermuda number@ml.bm  
Netcom number@sms.netcom.no  
Nextel number@messaging.nextel.com  
NPI Wireless number@npiwireless.com  
O2 (formerly BTCellnet) username@o2.co.uk Must be enabled first at 

http://www.o2.co.uk.  
Optus number@optusmobile.com.au  
Orange number@orange.net You will need to create a user 

account at orange.net first. 
Oskar number@mujoskar.cz  
Pacific Bell Cingular number@mobile.mycingular.com  
Pagenet number@pagenet.net  
PCS Rogers number@pcs.rogers.com Requires prior registration with 

PCS Rogers. 
Plus GSM Poland number@text.plusgsm.pl  
Powertel number@ptel.net  
Primtel number@sms.primtel.ru  
PSC Wireless number@sms.pscel.com  
Qualcomm username@pager.qualcomm.com  
Qwest number@qwestmp.com  
Safaricom number@safaricomsms.com  
Satelindo GSM number@satelindogsm.com  
SCS-900 number@scs-900.ru  
Simple Freedom number@text.simplefreedom.net  
Skytel – Alphanumeric pin@skytel.com  
Smart Telecom number@mysmart.mymobile.ph  
Southern Linc number@page.southernlinc.com  
Sprint PCS number@sprintpcs.com  
Sprint PCS number@messaging.sprintpcs.com  
SunCom number@tms.suncom.com  
SureWest Communications number@mobile.surewest.com  
SwissCom Mobile number@bluewin.ch  
Tele2 Latvia umber@sms.tele2.lv  
Telefonica Movistar number@movistar.net  
Telenor number@mobilpost.no  
Telia Denmark number@gsm1800.telia.dk  
Telus Mobility number@msg.telus.com  
The Phone House number@sms.phonehouse.de  
TIM number@timnet.com  
T-Mobile Germany number@T-D1-SMS.de  
T-Mobile Netherlands number@gin.nl  
T-Mobile UK  number@t-mobile.uk.net  
T-Mobile USA number@tmomail.net   
T-Mobile USA (Sidekick) username@tmail.com  
UMC number@sms.umc.com.ua  
Unicel number@utext.com  
Verizon Wireless number@vtext.com.   
Verizon Wireless 
(myairmail.com) 

number@myairmail.com  

Vessotel roumer@pager.irkutsk.ru  
Virgin Mobile Canada number@vmobile.ca  
Virgin Mobile USA number@vmobl.com  

http://www.tekvox.com/
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Vodafone Italy number@sms.vodafone.it  
Vodafone Japan number@s.vodafone.ne.jp  
Vodafone Japan 
(Chuugoku/Western) 

number@n.vodafone.ne.jp  

Vodafone Japan (Hokkaido) number@d.vodafone.ne.jp  
Vodafone Japan 
(Hokuriko/Central North) 

number@r.vodafone.ne.jp  

Vodafone Japan (Kansai/West 
-- including Osaka) 

number@k.vodafone.ne.jp  

Vodafone Japan 
(Kanto/Koushin/East -- 
including Tokyo) 

number@t.vodafone.ne.jp  

Vodafone Japan 
(Kyuushu/Okinawa) 

number@q.vodafone.ne.jp  

Vodafone Japan 
(Touhoku/Niigata/North) 

number@h.vodafone.ne.jp  

Vodafone Spain username@vodafone.es  
Vodafone UK username@vodafone.net  
Voicestream number@voicstream.net  
Weblink Wireless number@airmessage.net  
WellCom number@sms.welcome2well.com  
WyndTell username/phone 

number@wyndtell.com 
 

 

mailto:number@sms.vodafone.it
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TekControl 
TekControl is a Windows application running on the room’s computer to allow a user to easily control a 
TekMonitor via their PC. There are two operational modes for TekControl, Advanced and User. Only the 
Advanced mode allows for configuration of TekControl and requires a login password if in User mode.  
 
When a TekMonitor is selected during a search, TekControl gathers all the information from the 
TekMonitor and automatically renders a panel of buttons that represents the controls within the 
TekMonitor.  
 
Although TekControl is primarily used to control devices, it can also be used to control the computer it is 
running on or a group of computers. By utilizing the System Off Timer of the a TekMonitor along with an 
occupancy sensor TekControl can be configured to automatically shutdown, logoff, suspend, hibernate a 
computer when a user leaves a room. TEKVOX offers two occupancy sensors; a Large Room (1000 sq. 
ft.) and a Small Room (500 sq. ft). 
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Operation 
To allow for easy configuration, TekControl operates in Advanced mode when the program is first 
installed. Both the Advanced and User modes have configurable panel displays. TekControl also 
operates within the Window’s Tray for quick launching of TekControl or as a menu selection by a right 
mouse click. To configure TekControl, first select from the Tools menu and search for a TekMonitor.  
 
The menu operation of TekControl allows for the following: 

 File 
 TekMonitor 
 View 
 Tools 
 Help 

 
File 
The File menu selection allows for saving, recalling a configuration and exiting the program. Saving a 
configuration is only accessible within the Advanced panel. Different panel configurations and 
connections to different TekMonitors can be saved. Saving different configurations allows for the 
same laptop computer to be used in multiple rooms. The configuration settings are stored in a 
TekControl .tcd file. The Exit button on TekControl form only minimizes the program. To kill the 
program use Alt-F4 or the file menu Exit. 
 
TekMonitor 
From this menu selection the user can connect or disconnect a TekMonitor. 
 
View 
Use the View menu selection to select between Advanced or User panel. To switch to Advanced a 
login is required. The login requires both a user’s name and password. The user’s name is always 
Admin and the password always starts with “Tek” and is followed by the Pass Code of the 
TekMonitor. If the Pass Code is 6373, then the password is Tek6373. If the Pass Code is changed 
from TekManager, it is automatically transferred to TekControl. If TekControl is not currently 
connected to a TekMonitor and the Pass Code is changed, the TekMonitor will allow TekControl to 
connect using the old Pass Code and then transfer the new Pass Code.  
 
Tools 
The selections on the Tools menu changes via the Advanced or User panel. The Tools menu is used 
to configure the operation and display of TekControl.  
 
When the Advanced panel is selected the user is able to do the following: 
 

 Search and Select a TekMonitor 
 Configure Settings 
 Configure the Controls (Button Display) 
 Enable or Disable Auto-Shutdown 

 
When the User panel is selected, only the Auto-Shutdown selection is available. If Auto-Shutdown is 
set to On, the system is able to automatically logoff the PC when the System timer reaches zero. The 
configuration for Auto-Shutdown is set with in the Settings form. 
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Search 

To select a TekMonitor an Administrator must 
first search for a TekMonitor. From the Tools 
menu select Search and provide an IP address 
rage. If the Pass Code is not the default 6373, 
enter the new Pass Code. The bottom left 
position of the search form displays the IP 
address of the PC. This can help you in 
selecting an address range. 
 

 
 
 
 
 

Settings 

TekControl Settings menu allows for displaying of user information, setting the Timeout threshold and 
selecting to run this program at Windows startup. Settings are saved to a TekControl .tcs file when 
the Ok button is selected or the program is exited. For quick installation of other TekControl 
applications the .tcs file can be copied to other installations. This file is normally located in 
C:\Program Files\TEKVOX\TekControl. Only one TekControl application can operate with a 
TekMonitor. The user information is displayed above the TekMonitor Tray icon on three different 
events: 

 
 Icon Tray Message:  

o This message is displayed when the mouse 
is hovered over the Tray icon. 

 On Connect Success: 
o This message is displayed when TekControl 

connects with a TekMonitor. 
 On Connect Failed: 

o This message is displayed when TekControl 
is disconnects with a TekMonitor. 

 
System Off Message: 
This message is displayed on the Inactivity Timeout 
popup. 
 
Auto Connect: 
Enabling Auto Connect allows TekControl to connect 
to its last configured TekMonitor during startup of 
TekControl. This feature should only be enabled if this PC is always located in the same room as the 
controlled device. 
 
Run at Startup: 
Enabling the Run at Startup allows TekControl to automatically execute when someone logs onto the 
PC. This feature should only be enabled if this PC is always located in the same room as the 
controlled device. The Run at Startup option is stored within the windows registry. 
 
Auto-Shutdown 
Enabling Auto-Shutdown by checking the Auto-Shutdown checkbox allows the TekMonitor System 
Off Timer to execute the System Off Option when the TekMonitor’s System Off Timer reaches zero.  

http://www.tekvox.com/
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Timeout Threshold: 
The Timeout Threshold sets the point at which the countdown value of the System Off Timer will 
generate a Inactivity Timeout warning message. This message is used to inform the user that the 
system is about ready to shutdown. If the Inactivity Timeout message appears, a countdown is shown 
and three beeps will be heard. The user has the option to continue operating the system or let the 
timer expire causing the system to shutdown. The Timeout feature can be disabled by setting the 
Timeout Threshold to 0 or un-checking the Auto-Shutdown checkbox. 
 
Note: The System Off Timer must be set to a value greater than the Timeout Threshold. 

 

 
 

System Off Options: 
The System Off Option instructs TekControl as to what it shall do when the System Off Timer reaches 
zero. There are six selectable options available:  
1. None – No action is taken. 
2. Log Off – The computer is Logged Off when the timer reaches zero. 
3. Hibernate – The computer is placed in Hibernate which saves the current settings. You will not 

lose any work with Hibernate. During Hibernate the PC’s configuration is saved to the hard drive. 
4. Standby – Operates like Hibernate but save the configuration to Ram for fast execution.  
5. Power Off – Shuts down the computer. All Work will be lost. 
6. Program – Allows for the selection of a program to be executed. 

 
Logo Button: 
The Logo button allows the Default TEKVOX logo to be replaced by a user logo. The size of this logo 
must be less than 180 Width by 60 Height in pixels. 
 
Default Log Button: 
Selecting the Default Logo returns the logo back to the TEKVOX logo. 

Configuration 

Once a TekMonitor is selected all of its control commands are displayed on the panel. To limit the 
control items within the different panels, select the Control menu item. This displays the Control 
Configuration form. This form allows for deselecting items from the different panels and the Windows 
Tray. Using the right mouse menu, commands can be moved up or down and a Tray command can 
be selected to be activated by double-clicking on the Tray icon. This is called Quick Click. By default 
double-clicking the Tray icon displays the TekControl panel. The operation of the Quick Click is 
displayed at the bottom left of this form.  
 
Having only the necessary control commands displayed within the different panels and moving 
commands up or down improves the operability of TekControl. 
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TekPatrol Reporting Subsystem Instructions 
TekManager has the capability to log events and status information to a user defined SQL Server 
database. This database can also reside on the local PC’s hard drive. The recorded information can then 
be displayed in the two types of Usage Reports called Events History and Events Summary. These 
reports can also be saved to a CSV file. For more refined reports a user can always access SQL Server 
directly. 

Usage Reports 

There are two types of usage reports: Events History and Events Summary. These reports allow the user 
to view filtered information by a date range from the recorded events. Once are range is selected, click on 
the Load button to display the data. The lower left window list the TekMonitors, the lower center window 
displays the Command filters and the lower right selections are the Quick Filters. 

Various filters can be set to focus on a particular TekMonitor and/or a particular command. The Quick 
Filters are used to focus quickly on the Power, Source or you can enter your own event. 

 
Column Names 
Room, Monitor and Port – identifies the device being monitored. 
Command – is the particular event or status that is being monitored. 
Setting – is the actual value of the setting or status. 
Hrs & Mins – is the duration, or amount of time this status or event was in effect, since the last time 
the command was recorded. 
Ending Time – is the end time for the duration in Events History. 

The  Save CSV  button is used to export the information in the data grid to a Comma Separated 

Variable (CSV) file that can then be imported into spreadsheets, databases and word processors. 
Location, Building, Group and IP Address are added to each record. 

TekManager Main Menu – Reports 

The reporting functions are accessed from the main menu bar of the TekManager application under 
Reports. The following submenu items are available: 

 
Report Setup 
 

Enable Checkbox  
This turns on the event logging. If any errors are encountered, for example, the SQL Server becomes 
unavailable when logging is attempted, logging will stop and this box is unchecked. A status bar 
message in the lower left indicates logging is enabled or error conditions. 
 
Email Notification 
Not implemented (Future). 
 
Filters 
For each TekMonitor in a project you can control which events get logged. By default, all defined 
events are logged. This can generate a significant amount of data. Users should determine which 
events they are likely to be interested in and turn off the rest. 
Select a TekMonitor from the drop-down list and uncheck any items that do not need to be logged. 
Click the Apply button when done in order to save the settings for the current monitor. Do this for 
each TekMonitor. Click the Apply button even if no changes are made to the filters. 
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Database 
Provide the connection and login information needed for your environment. If you are unsure about 
what to enter, please contact your database administrator. 

 

     
Filters                Database 
 

 

Events History 
Events History displays the time stamp of the events for the selected commands within a date range. This 
is report is useful to determine a time and date that a particular event happened. 
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Events Summary 
Events Summary calculates the hour usage for the selected commands within a date range. Use this 
report to determine the amount of usage a device is getting. 

 
 

Notes: 

- Multiple similar events may be recorded. For example, multiple “System Power Off” events may be 
recorded in a row. This occurs because all events may be recorded several times a day, even if 
none of them changed. Each of these events will have its own duration. 

- The data being reported on is prepared at midnight each day. Therefore, the current day’s events 
cannot be displayed. 

- If the TekManager application is not running, events are not recorded and daily summaries are not 
produced. If the application is restarted after several days, there will be log events with greater 
than 24 hour duration.  

- Reports can only display results from data logged when the TekManager application is running 
continuously throughout the day. 

- Be sure that the computer does not go to “standby” or “sleep” or some other power-saving mode 
that would result in the application pausing. 

 

http://www.tekvox.com/


 

 48 

SQL Server (Express) Setup 

The file InstallTekReporter.sql located in the TekManager directory (C:\Program 
Files\TekVox\TekManager) creates the database, tables and stored procedures. This should be run on 
the SQL Server instance that will be used to store the logging records. To load the installer program run 
SQL Server Management Studio Express and select File Open with the above mentioned file. Press the 
Execute button on the toolbar to create the databases. To view the databases, exit SQL Management 
and run it again. 

MySQL Server Setup  

The file MySqlInstallTekReporter.sql located in the TekManager directory (C:\Program 
Files\TekVox\TekManager) creates the database, tables and stored procedures. This should be run on 
the MySQL Server instance that will be used to store the logging records. To load the installer program 
run MySQL Workbench and open a connection to the desired server instance.   Select “Open SQL Script” 
from the File menu with the above mentioned file. Select the Execute button on the toolbar or select the 
“Execute All” from the Query menu item to create the databases.   This setup requires the MySQL ODBC 
driver be present on the host system to operate.  The ODBC option should be selected with the 
appropriate driver nomenclature in the Report Setup/Database panel of TekManager. 

 

This installer file creates the following: 

Databases: 

TekReporter – default name, can be changed to anything. The database name will be entered on the 
Reports Setup / Database panel. 

Note: The information for more than one project can be stored in the same database.  

 

Tables: 

TekMonitorAsset – information about individual monitors 

TekMonitorEventLog – raw logging information. Gets processed and deleted daily after adding 
processed records to: 

TekMonitorEvents – processed log records, current up to the most recent running of the 
TekMonitorDailySummary procedure, usually at midnight. 

 

Stored Procedures:  
(These stored procedures are initiated from TekManager) 

TekMonitorAssetUpdate – whenever a project file is saved, the monitor information in this file is 
refreshed. 

TekMonitorEventLogInsert – adds records to TekMonitorEventLog whenever an event occurs. 
The current status of all event and status indicators is written whenever the TekManager 
application starts and right before and after the daily summary processing. 

TekMonitorDailySummary – processes all the raw log records for a particular project, calculates 
durations for each of the events and writes it to the TekMonitorEvents table. The processed raw 
records are purged. 

tvEvents – used by the Event History Display in TekManager to select records for display. Parameters 
are date range and current project name. 
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Database Management Responsibilities 

The user is responsible for managing the database including monitoring database size and purging of log 
records. With Reporting Enabled turned on, the TekManager application can add a large amount of data 
to the database, depending on the number of monitored devices, the settings of the reporting filters and 
the activity of the devices. 
 

TekDebug Usage Guide (TEK 2 + Only) 
 
The TEK 2 provides for a new debug feature utilizing an onboard USB OTG port.  This feature allows for 
local identification and debug of TekMonitor setup and operational parameters when the network is 
inaccessible. 
 
Initially, tie a USB – A to Mini-B cable (Belkin F3U138-10 or equivalent) between the host PC and the 
TekMonitor debug port, and then execute the TekDebug program from the host PC.  Launching the 
TekDebug program first attempts to establish USB connection with the TekMonitor.  If established, a 
“TekMonitor Found” message is reported; otherwise a “TekMonitor Not Found” message is indicated. 
 

 
 

Depressing the enter key provides a list of current setup parameters along with a menu of commands. 
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Print Log 
 
The “Print Log” command produces a list of all events or errors stored within the TEK 2 during its normal 
operation. 
 

 
 

Clear Log 
 
The “Clear Log” command clears the error log. 
 

Pass Thru 
 
The “Pass Thru” command allows for passing direct ASCII data to the attached projector by typing in the 
character stream to send, and depressing the enter key.  To exit this mode, a stream of three lower case 
Xs, “xxx” are entered.  Data subsequently received from the projector is displayed on the screen.  Upon 
entering the pass thru mode, a couple of setup options need to be entered.  The first is to select which 
serial port to transmit and receive from.  The projector is typically attached to Channel 1.  The second 
option allows for the 
addition of a line feed 
character, or prefix a 
start-of-transmission 
(STX) character as well 
as appending an end-of-
transmission (ETX) 
character to the stream 
entered automatically.  
The final option allows for 
echoing the transmitted 
stream along with any 
received data. 
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Network Config 
 
The “network config” command allows for editing the network configuration settings.  These settings begin 
with the unit IP address, each octet is displayed allowing a new value to be entered, or just accepting the 
current value by depressing the enter key.  An entered IP value of 0.0.0.0 defines DHCP mode.  Once the 
IP address is entered, Gateway and Subnet masks may be entered or modified in the same manner.  
Values entered are not permanently stored until the “Save and Exit” command is executed. 
 

 
 

 

Factory Defaults 
 
The “Factory Defaults” command resets all setup values to their initial defaults. 
 
 DHCP mode = enabled 
 SMTP port = 25 
 TEKPATROL port = 5070 
 TEKCONTROL port = 5072 
 PASSCODE = 6373 
 Serial Port 1 = 9600,N,1 
 SerialPort2 = 9600,N,1 

Save and Exit 
 
The “Save and Exit” command forces a save of data to the TekMonitor non-volatile storage area.  Once 
saved, the unit is reset, disconnecting the USB channel.   The TekDebug program will have to be 
restarted in order to reestablish connection. 

Reset 
 
The “Reset” command forces a reset of the TekMonitor resulting in a disconnection of the USB channel.  
The TekDebug program will have to be restarted in order to reestablish connection. 

Quit 
 
The “Quit” command disconnects the USB channel, and the TekDebug program will have to be restarted 
in order to reestablish connection. 
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